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Introduction 
The Basic Photoshop workshop taught the user interface, where most essential tools were located, raster 
image basics, image resolution how to do basic color corrections and retouch scanned images. Hopefully you 
have built upon these skills and are ready for the really fun stuff. If you haven’t worked with Photoshop 
since, review the materials prior to proceeding.   

Photoshop is a program you learn by doing! If a person wishes to become competent, they will need to 
invest time to investigate the program’s capabilities. When learning Photoshop, don’t worry about creating 
great images initially.  Learn the tools and their capabilities. It is also a good idea not to work under pressure 
until you feel comfortable with the tools, as you will only become frustrated with the program. Finally, it is a 
good idea to have a knowledgeable Photoshop user available to help you when, and you will, get stuck! 
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Setting up the Shop 
Screen Modes  

 
Standard Screen mode is the default viewing mode in Photoshop and is the mode most people use. This 
screen mode maintains standard window conventions found in the rest of the operating system and 
programs. It is very useful for normal sized images and multiple images.  

 
Full Screen Mode with Menu Bar 

The middle button on the screen mode selector selects Full Screen Mode with Menu Bar. You can toggle 
through all modes by simply hitting the “F” key. Full Screen Mode removes the title bar and displays the 
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current image full screen. If there are several images open, only the current image will be visible. To access 
the other images, select “Windows” on the Menu Bar, then go to the bottom of the panel to select a file. 
The selected file will be displayed in the viewing mode that was assigned to it, so your current mode could 
change. 

Full Screen Mode 

Full Screen Mode is similar to Full Screen Mode with Menu Bar in that the title bar is removed, but goes 
further by moving the menu bar to the Tools palette as a fly-out type menu. This mode is a good mode to 
use if the user is proficient with hotkeys, as it displays the most real estate. 

Hiding Palettes 
After picking the proper display mode, the next image viewing tip is to hide palettes so that you can see the 
entire image. To accomplish this, simply toggle the “Tab” key to display and hide all palettes.  You can also 
hide or show individual palettes by going to “Window” on the Menu Bar, and choosing to show or hide. 
Most menus are “dockable” which means you can transfer the tabbed menus to another panel. This highly 
customizable feature is nice when you have specific tasks to perform and do not need extra clutter. 

Zooming 
Many times what separates an average image from a superior image is detail. Magnifying, or “zooming” in on 
an image allows the user greater flexibility and control over the painting tools while editing. Zooming in 
allows the user to work more accurately and efficiently. Zooming can be accomplished by several methods.  

Zooming with the Zoom Tool   

  The initial method most people use to zoom is the Zoom Tool, which is located on the tool 
palette. The zoom tool looks like a small magnifying glass. After selecting the zoom tool, the arrow 
cursor changes to a magnifying glass with a plus sign ( + ). Clicking the current image zooms in, and 
allows the user to zoom until the plus goes away, which means you can zoom no more. Holding 
down the Alt key changes the default zoom tool from a plus (zoom in) to a minus (zoom out). 
Double-clicking the zoom tool automatically changes the image’s magnification to 100 percent. 

Zooming with a Mouse Wheel 

If your mouse is equipped with a mouse wheel, you can easily zoom in and out by selecting a current 
image and scrolling the wheel, forward to zoom in, backwards to zoom out. Using a wheel mouse in 
conjunction with the spacebar grabber hand is an efficient way to navigate smaller images, and will 
work while performing operations such as cropping. 

Zooming with Control and ( - , + ) 

Another method of zooming is to use hotkeys. To zoom in with hotkeys, hold the Ctrl key down, 
then press either the plus ( + ) or minus ( - ) keys until the desired zoom level is achieved.  

Zooming with Navigator 

Using the Navigator tool is the latest method designed to help 
user navigate large images. In fact, when you use other 
methods, you can see the Navigator panel updating as you 
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zoom. Navigator is particularly useful with large images. When the image is scrollable, notice the 
indicator square can be moved to locate a specific area. Specific magnifications can be entered in a 
text box in the lower left. 

 
Hand Tool 

  The Hand Tool allows the user to move the digital image very much like your hand would move an 
actual photograph on a tabletop. You can select the Hand Tool from the Tool panel or in most cases press 
the spacebar. When you click the hand on the picture, the icon changes to a gripping hand, which provides 
the reference point as the image is dragged to the desired viewpoint.  

 

Displays and Cursor Preferences 
Another helpful tip is to ensure the cursor display 
preferences are set properly. To access Preferences, go 
to the menu bar and choose:        
 “Edit/Preferences/Displays & Cursors”. There are 
two types of cursors, Painting and Other. For the 
Painting Cursor make sure that Brush Size is selected 
and for Other Cursors make sure “Standard” is 
selected, then hit “OK”.  

Standard mode lets the user see a descriptive picture 
icon of the tool being used. The Precise mode has a 
cursor that is a crosshair. Brush size mode displays a 
cursor the approximate brush size of the painting tool 
selected. You can always select Precise cursor mode by 
toggling the Caps Lock key. This is helpful to locate a 
single pixel brush over certain backgrounds.   
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Selection Tools 
Marquee, Lasso and Magic Wand  

The selection tools are located on the top portion of the tool palette.  The Marquee Tool features 
the Rectangular, Elliptical and Single Pixel marquees (both horizontal and vertical). The Lasso 
selection tool features the Lasso (freehand), the Polygonal Lasso, which selects using straight lines 

and the newest addition, the Magnetic Lasso, which appears to hug or snap to the edge of a shape. The 
Marquee and Lasso tools both allow the user to feather and anti-alias the selection. The Marquee tool also 
allows the user to fix aspect ratios and fix size. 

The Magic Wand tool senses color variation and selects color bases on Tolerance settings chosen by the user. 
These tolerances can used to select in a Contiguous (next to) mode. The Magic Wand can be set to select 
across multiple layers by viewing a multi-layered image as a composite image. Investigate this setting if you 
are having difficulty selecting on a particular layer; it’s probably not a bad idea this remain unchecked unless 
you have a specific need for it 

Selection Methods 
Normal Selection Mode 

 
To create a selection or deselect an existing selection, click the first button.  

Adding to a Selection 

  
Once you have created a selection, you can add to that selection by clicking the second button, and 
use the cursor to select the additional area. 

Subtracting from a Selection 

 
To subtract from a selection, click the third button, then select the area within the existing selection 
that is to be removed from the selection.  

Selection by Intersection 

 
To create a selection by intersecting two selections, click the fourth button, the select the region that 
when combined with the existing selection creates the desired shape, and release the mouse button.  

Hotkey Alternatives  

Hotkeys are an efficient method that allows the user to add and subtract from a selection. The Shift 
key adds to a selection, the Alt key subtracts and the Shift + Alt keys together allow the user to 
intersect the selection. Holding the Ctrl key down will allow the user to cut the underlying image 
based on the selection, Ctrl + Alt will clone the underlying image based on the selection. Pressing 
the Shift key after cutting or cloning a selection will constrain movement horizontally or vertically. 
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Basic Selection Tips 
Hiding marquee 

Sometimes it is difficult to see parts of your image because of the “marching ants” indicator that 
designates the boundary of your selection. To toggle the selection indicator visibility, hold the Ctrl 
key down, then press H.  

Feathering 

Feathering can be assigned prior to making a selection or can be applied afterward. To assign a 
feathering selection value prior, simply choose the selection tool and enter the feather value prior to 
making the selection. If a feather is needed after a non-feathered selection has been made (as when 
using the magic wand), go to the menu bar and choose “Select/Feather”, then enter the desired 
amount.  

Stroke 

To “stroke” a selection means to apply a line that follows the contour of a selection. To apply a 
stroke a selection, go to the menu bar, then choose “Edit/Stroke”. Users have the options of 
stroking the outside, inside or centerline of a selection a selection and choosing the stroke thickness 
in pixels. 

Inverse 

To invert a selection, go to the menu bar, and then choose “Select/Inverse”. Inverse will invert the 
current selected area to unselected and the formerly unselected areas will now be selected. This 
simple but handy feature can provide be extraordinarily helpful if used correctly.  

Modify 

Modify commands are located within the Select Menu found 
on the menu bar. Modify allows the user to create borders, 
smooth the contours of existing selections and finally to 
expand or contract existing selections. Border uses the existing 
selection as a centerline, and creates a selection border with 
boundary areas determined by user input. Smooth removes 
some of the rough corners that can occur when drawing 
objects, or to soften hard edge geometric shapes. Expand and 
contract increase or decrease the selection based on use input.   

Similar 

The Similar command is located within the Select Menu found on the menu bar. Similar is a very 
handy command designed to create a selection based on colors of the current selection. This can be 
very useful when selecting the background in tight areas. 

Transform Selection 

There may be times when you need to resize, skew, rotate or stretch a selection without altering the 
pixels in the selection. Transform Selection releases the selection’s pixels and floats the selection 
allowing the user to manipulate the shape. 
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Layers & Paths 
Layer Organization 

Adding Layers 

 
To add a layer, just click the New Layer icon on the bottom of the Layer Tool palette. A new layer 
will be created above the currently selected layer.  

Deleting Layers 

 
To delete a layer, simply drag the undesired layer to the Trash icon on the bottom of the Layer Tool 
palette and it will be deleted- no questions asked. You can also click the Trash icon and the selected 
layer will be deleted, after confirming this is what you intended. You can also right click above the 
undesired layer, then click “Delete”. 

Making a copy of a Layer 

 
To copy or duplicate a layer, just drag the desired layer to the New Layer icon on the bottom of the 
Layer Tool palette. The new copy of the original layer will be created above that layer, and will 
automatically become the selected layer. The duplicated layer will retain the original’s name, but 
automatically append “copy” to it. You can also right click above the desired layer, then click 
“Duplicate”. 

Arranging Layers 

To arrange layer above or below another layer, click down on 
the layer, and while holding the mouse button down, drag 
the layer up or down to the desired level. When the layer can 
be dropped into the desired level, the program indicates this 
by highlighting the area between two layers. Arranging layers 
may take a little practice, especially when moving layers to a 
layer set. 
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Layer Properties 

Layer Properties allows the user to organize layers by using 
descriptive names.  Users further organize layers by color 
coding. 

 

Layer Visibility 

Sometimes it is helpful to disable a layer’s visibility to see the 
lower levels better. To do this, simply click the eye icon for the 
desired layer. To make the layer visible again, click the area 
where the eye icon was visible earlier.  

 

 

Linking Layers 

Layers can be linked together so that the pixel, vector or font 
information contained on the linked layers can be moved or 
transformed together.  To link a layer, select an active layer, 
then click the layer you wish to link. 

 

 

Layer Sets 

 
Layer Sets are invaluable in large, complex illustrations. Organizing elements into Layer Sets makes 
moving and toggling visibility easier, by grouping many layers into a set. This eliminates the need to 
link or change the visibility on many individual layers. 

 

Transparency Lock 

 
Transparency Lock allows editing of only the existing pixels, not areas without pixel information.  

Position Lock 

 
Position Lock freezes the location of pixels on a layer while still allowing the pixels to be edited. 
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Blending Modes vs. Adjustment Layers 
Layers have the ability to blend in different modes. The default blending mode is Normal, but other modes 
such as Multiply, Screen, Lighten, Luminosity, etc., can produce exciting effects. Blending layers require a lot 
of experimentation to achieve results, and after this experimenting, sometimes it’s back to Normal mode! 

Adjustment layers treat all layers below the adjustment layer as a composite image that can be adjusted with 
some of the same image controls flat images use under the “Image/Adjust” menu. 

Layer Effects 

 
Layer Effects eliminates the former drudgery work necessary to jazz up. Users can instantly create glows and 
drop shadow simply by select a layer, click the Layer Effects icon on the bottom of the Layer Tool palette. 
As with most things Photoshop, experimentation is required, and it is easy to get tacky quickly. 

Copying a Layer Style to another Layer 
Once a user has struggled and experimented with a layer and has the desired look, Photoshop allows the 
effects to be easily copied to other layers. To copy a layer style, right click the layer that with desirable effects 
and on the resulting fly-out menu, select “Copy Layer Style”.  Next, right click the layer where the effects 
are to be applied, and on the resulting fly-out menu, select “Paste Layer Style”. 

Text and Vector Shape Layers 
Text and Vector Layers are special layer types that do not allow painting tool editing, unless the layer is first 
rasterized. Text layers can be re-editing and altered much the same as a word processing program. Vector 
Shapes are actually clipping paths with assigned colors. These vectors can be altered with path editing tools. 
Rasterizing Text or Vector Shape should be the last step as the text or vector editing ability is lost during the 
process.   

Masking 
Quick Mask 
Quick Masks allow users to “paint’ a mask. Painting tools, such as the Brush and Eraser Tools can 
be used to add and subtract from the mask, as well as vary the opacity. Using Quick Masks also 
enable the user to zoom in on detail while not worrying about accidentally deselecting.  

Layer Masks 
Layer masks are assigned to a layer and can effect the transparency 
of the image. Layer masks cannot be applied to the background 
layer. To add a layer mask, go to the menu bar and select 
“Layer\Add Layer Mask\Reveal All”.  Nothing has effected the 
image yet, but notice that the layer icon has another icon beside it. 
This is the mask layer. Click this mask layer to highlight it and make 
sure the Foreground and Background color are black and white. 
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Use the Gradient tool to apply a gradient to the mask layer. Notice the areas that are lighter allow the pixels 
to show, but the darker area does not allow the image to come through. At first, users that have experience 
with alpha channels may think this is backward (in an alpha channel, white is 100% opaque and black 100% 
transparent), but because this is a mask, not a channel.  

Using Paths 
Paths are a familiar concept to people with experience in programs such 
as Adobe Illustrator, CorelDraw or Macromedia Freehand. Photoshop 
uses basic path tools to accomplish certain tasks such as creating or 
adjusting clipping paths. Although it’s possible to draw vector objects 
with Photoshop, most experienced users will create vector drawing in 
better suited programs. Here are some short descriptions of each tool. 

Pen Tool 
The Pen Tool is used to draw paths. When the Pen tool is used, Photoshop automatically creates a work 
path that can be viewed on the Path menu. The Pen Tool draws with Bezier points, which can be pulled to 
adjust the curvature. You can also create straight lines by clicking without pulling the handles of the Bezier. 
The Freeform Pen Tool allows the user to draw freehand, without using Bezier points. 

Path Select Tool 
The Path Component Selection Tool allows the user to select 
individual paths. The Direct Selection Tool allows editing of point 
on the selected paths. 

Add Anchor Point 
To add additional points, use the Path Select tool to select the path, then go to the Pen Tool fly-out menu to 
select the Add Anchor Point Tool. 

Delete Anchor Point 
To delete points, use the Path Select tool to select the path, then go to the Pen Tool fly-out menu to select 
the Delete Anchor Point Tool. 

Change Anchor Point 
To convert between straight and Bezier anchor points, use the Path Select tool to select the path, then go to 
the Pen Tool fly-out menu to select the Convert  Point Tool. 

Resources 
Photoshop 6 For Windows & Macintosh, Weinmann and Lourekas,  Peachpit Press, Copyright 2001 

 


